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Intro.

Effective aerodynamics is an essential part of overall vehicle design and manufacturers can assess developments to
the aerodynamics of their vehicles by performing a Coastdown test.

This is a test in accordance with EU directive 70/220/EEC — annex Ill, which measures the effects of wind and road
resistance, based upon time taken for a vehicle to coast from one speed to another, with the engine in neutral gear.
A major problem associated with this testing is the requirement for a very long, flat test track, to allow sufficient
time for the vehicle to coast from 125kmh to 5kmh (for example — range is user definable).

The Racelogic solution breaks the testing down into multiple user-definable segments, to allow the full range to be
subject to the test without the need for an excessively long test track.

The software takes the test data and performs statistical analysis in real time on this, as defined in the directive, to
provide instantaneous indication of when the required statistical accuracy has been met.

The VBOX Coastdown software is designed for use with VBOX Ill or VBOX3i, as it is optimised for the dynamic
response of the VB Ill and VB3, particularly when used in conjunction with an IMU.

NOTE when this software is used with VB3i, the serial link to the PC must be via the VB3i RS232 serial data output.

GPS & GPS + IMU.

The Racelogic Coastdown software can be run using GPS only data in open conditions where the GPS antenna has a
good, unobstructed view of the sky, but for the best results even in good conditions it is advised to connect an IMU.
The use of an IMU smooths the velocity trace which results in the required statistical accuracy being achieved more
quickly, thus reducing the test time.

The smoothing achieved with the use of an IMU also makes the test capable of being performed in conditions which
are less than ideal, such as in areas of heavy tree / building coverage, or for test tracks where the sky may be
obscured by bridges.
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Coast Down test Theory.

The test is performed in accordance with European
Directive 70/220/EEC — Annex Ill and is based upon
statistical evaluation of a minimum of 4 test runs.

The test results are considered to be valid when the
statistical accuracy of the average test values is < 2%.
The test can be performed at any speed according to
the manufacturer’s requirements, but must follow the

Coastdown Software

Direction of
wind

1]

general procedure below: Direction 1 Direction 2
Stop speed - -|-|- - --IFF - Start speed
1. Accelerate the vehicle to a speed 10km/h 85km/h 125km/h
greater than the test start speed (user
definable — 125km/h in the diagram opposite) 1
2. Place gearbox in neutral o o
3. Measure the time taken for the vehicle to D_'r9°t'°“ 1 Test D'V?Ct'on_ 2
decelerate from the start speed to the stop (into P::Iead Track (with Ja"
speed (user definable — 85km/h in the wind) wind)
diagram). This is time t;
4. Repeat steps 1-3, but in the opposite \
direction. This is time t,
5. Take the average timg of these two test runs Direction 1 Direction 2
(tl + tz)/z ThIS IS the time T Start Speed - - - i Stop Speed
Repeat steps 1 to 5 until such time that the statistical 125km/h 85km/h
accuracy of the average
1 n
T = —Z Ti
n 3
i-1
is not more than 2% Example of vehicle movements for
Coastdown testing
The statistical accuracy (p) is defined by:
_ (t. S) 100
Where:
i 2
s = t (Ti-T) t = Coefficient given by the table below,
n-1
n = Number of tests
s = standard deviation
n 4 5 6 7 8 9 10 11 12 13 14 15
t 3.2 2.8 2.6 2.5 2.4 2.3 2.3 2.2 2.2 2.2 2.2 2.2
t
? 1.6 1.25 | 106 | 094 |0.85 |0.77 |0.73 |0.66 |0.64 |0.61 |0.59 |0.57
n
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Getting Started.

Step 1: Setting up the VBOX on a Vehicle.

Set the up the VBOXIII/VB3I on your vehicle as instructed in the VBOXIII/VB3I user manual.

If an IMU is being used connect the IMU to the VBOXIII/VB3I CAN socket using the RLVBCABO5CS cable supplied with
the IMU.

RLCABOO05/CS

——— @

RLCABO10 DC Power

RLCABOO1 Q GPS Antenna

@CELOGIC I

VBOXa3i

Step 2: Configuring the VBOX with VBOX Tools.

Prior to setting up and performing the Coastdown test, the VBOXIII/VB3I will need to be configured to ensure that it
is in the correct operating mode for the test. This is particularly important if your VBOX is used for other types of
testing as well.

NOTE: Once this is done it will not need to be repeated providing that the VBOXIII/VB3I configuration does not get
altered.

The following instructions should be followed using your VBOX Tools software manual as a reference.
e Open VBOX Tools software.

Next click on the VBOX Set-up Icon. A dialogue box will open to allow you to configure the VBOX.

o Select Channels » Standard and then ensure that all channels from listed from Satellites to Trigger event
time are ticked for sending over serial and log to compact flash.

e Click the Internal A-D and VCI modules tabs to ensure that every box is un-ticked.

e Select the 3-axis module window and ensure that the X Accel and Y Accel boxes ONLY are ticked for ‘log to
Compact flash’ and ‘sending over serial’.
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e Select the Logging Tab and ensure that:

— Serial o/p is set to 20Hz
— CFlog rate is set to 100Hz
— Log conditions is set to Log only when moving

e Select the GPS Tab and ensure that:
— Kalman filter velocity option is set to zero.
—  GPS Optimisation — if using an IMU, this should be set to high dynamics to ensure that the IMU data
is integrated when the GPS data is noisy. If you’re not using an IMU, set GPS optimisation to low

dynamics to compensate for any GPS noise.

Step 3: Running the Coast down software.
e C(Click on the Coastdown Software desktop shortcut, to run the software.

e Ensure VBOXTools software is closed so that it does not hold the Com port.
e QOpen the ‘Options’ drop down menu and select the correct Com port for the Coastdown software to use.

Head Office: Unit 10, Swan Business Centre, Osier Way, Buckingham, Bucks MK18 1TB, England

Tel: +44 (0)1280 823 803 Fax: +44 (0)1280 823 595 Email: vbox@racelogic.co.uk Web: www.racelogic.co.uk




RACELOGIC

VBOX Coastdown Software

Step 4: Aligning the IMU.
If an IMU is to be used then the Coastdown software will require the use of the IMU to be enabled and then the
position of the IMU will need to aligned.

e Open the ‘Options’ menu and then ensure that the “Use IMU” option is ticked
e Drive the vehicle to the test track on which the Coastdown test will be performed and stop the vehicle.
e To perform the IMU alignment, click:

Options
Options 4§ COM Port >
»>IMU @ Custom Test Range ...

» Alignment aid. :

436 Speed Units » |
fl AlignmentAidForm =10Ix[|  This will bring up the screen opposite. The blue dot is the
- - position of the IMU with respect to both the X and Y axis and
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the red circle is a target area for the blue dot.

Physically adjust the mounting of the IMU so that the blue dot
falls entirely within the boundary of the red circle — the closer
this can be set to the 0 crossing of the axes the better, but to
position the blue dot within the circle indicates that the IMU is
within 1.8° of the horizontal and vertical axes.

With the blue dot positioned correctly, click OK. The IMU
alignment data is now stored within the software.

Step 5: Selecting a test range.
e Select the required test sub-range in the test range indicator.

e If the range options are not suitable then configure the ranges to what is required for your Coastdown test.
For more details see the ‘Software Configuration and Test Setup’ section of this manual.
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Step 6: Starting and Running the test.

1. Click Start, or press F2. Your vehicle GPS speed and, if used, IMU speed will now be |:
displayed in the speed trace window(s). In the Speed vs. Time window, the GPS Start F2 :
speed is displayed in grey and the corrected GPS speed, incorporating IMU data, is [ :
displayed in red.

2. Accelerate to 5km/h (or mph, depending upon speed units
selected) above the required sub-range start speed. During this
acceleration, the test status indication will show the blue TEST
ARMED box.

TEST ARMED

3. Once the Start speed + 5 has been reached, the test status will
change to the yellow WAITING FOR START SPEED box. Place
gearbox in neutral and start coasting, maintaining direction of
travel (Direction 1).

WAITING FOR START SPEED

4. When the start speed has been reached, the test status

indicator will change to the green RUNNING box. RUNNING

5. Continue coasting. If you have set intermediate steps in your range then the time taken to Coastdown
between each intermediate speed will be displayed in the test progress table in real time.

6. Continue coating until the sub-range end speed has — o115 151 ‘105_095 ‘ ‘ ‘ ‘
been reached. At this point all of the intermediate Drecton 1 06.745 |07 567
steps in the test progress stable will be completed for Drecton2  |05.070 06672 07.506
first run, in that direction only and the green TEST Test average |06.007 06.708 07.581
RUNNING box will revert back to the blue TEST Rurning Mean (065,125 06,742 (07.589
ARMED box. Rurning stdev (00,106 (00,113 00,213

Accuracy % OT6210 01,565 02 641

4

7. Repeat steps 7.3 to 7.7, in the opposite direction
(Direction 2).

8. Continue performing steps 7.3 to 7.8. The test progress table will continually update with the average time
for each intermediate section, based upon the time taken to perform the test in both directions. As the test
progresses, the software will calculate, in real time, the running mean of the test averages and will also
calculate the standard deviations of these means.

Based upon the standard deviation, the accuracy % will either be greater than 2%, in which case the box will
have an orange fill (for at a glance identification) or less than 2%, in which case the box will turn green.

9. Repeat steps 7.3 to 7.9, until the statistical accuracy for all intermediate ranges is below 2%. All Accuracy
boxes will have a green background.
10. Repeat steps 7.3 to 7.10 for each test sub ran

11. When the test is finished, click Stop or press F2. The test results are automatically saved as a .TXT file to your
chosen directory. For instructions on how to select a Log file directory please refer to ‘Software

Configuration and Test Setup’ section of this manual.
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Software functions

q
{

)
When you double click the Coastdown software icon g the Racelogic logo and licensee details will appear for a
few seconds and then the software will open directly to the main screen, as given below.

Layout
1 2 3 4 5 6
5N 05 58 05 @ 510
Test & 025020 020015 015010
Dicection 1 Erf. 745 07.567 8
7 | Dwrection 2 %5 V0
Test Awerage |05 007
Renning Mean |06 S g
Renning stdev |00, 106 00,113 00,213
recurscy |21 ONSOH) 02641 10
|
§1 g Pollctuchimgemmdnanisnll 32
: & b 12
Licenseq To: RACELOGIC 13
Racelogic Ltd ~ . bR
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Label Definitions

1 Menu / setup buttons — Allows the user to define all test conditions.

2 Test Range Indicator — This section gives the details of the defined test ranges and indicates which
range is currently under test.

3 Start / Stop button — This button starts and stops the current test.

4 Test Status Indicator — This indicates the current status of the test in real time, in both English and
in a colour coded system.

5 Reset Button — This clears all results and returns the test to the start conditions.

6 Reset direction button — This button is used to reset the test start conditions for a single run (in one
direction), should that run be invalid for any reason. The software will keep the test data for the
entire test setup, up to and including the previous run in the opposite direction.

7 Test Progress Table — This table shows the results for each test increment in both directions, along
with the average of these two directions, the running average of all the test so far, the standard
deviation of the running average and the statistical accuracy of the results, all in real time.

8 Live Speed Window — This window shows the current speed of the vehicle, in either MPH or KMH

9 Live GPS UTC time window — This section displays the current Coordinated Universal Time in 24h
format. This resets each day from 00:00h (midnight)

10 Live Accelerometer data — This is the IMU data in the horizontal and vertical plane. (X&Y axis)
11 IMU data trace — If used, this graph shows the trace for the data received from the IMU.

12 Speed vs. Time Trace — This is a real time plot of the speed of the vehicle, whether accelerating to
start conditions of decelerating due to a Coastdown.

13 Licensee details — Name and logo of company to whom the software is licensed to.
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Software Configuration and Test Setup

Prior to performing the Coastdown test, you will need to configure the
software and set-up the test parameters to your requirements. This is done
by using the menu / set-up buttons in the top left corner of the screen.

File View Options Help

e File - The File drop down menu contains options concerned with saving / replaying results files and allows
you to load a .vbo file, set the log file location and choose the replay speed.

e View - The View drop-down menu allows you to see the graph of the data from the optional IMU, plus
change the time base of the IMU data trace and the Speed vs. Time trace.
e Options - The options drop down menu allows you to configure the PC COM port, the Custom test range(s),

the IMU usage and the speed units

e Help - The Help drop down menu provides a shortcut to this user manual and gives details of the software
version, etc.

The functions in these menus are described in more detail below
File Menu
In the file menu, you can recall a saved Coastdown test and replay this. This is explained in section ‘Replaying Saved

Results’

Configuring a Log File Location

To define the folder into which you wish the software to save the results. File View Options Help
Select : File L oad VBO Fil
» Log file location oad AEL e -
Log File Location ...
Replay Speed »
This will then bring up the directory structure, where you can choose the folder jge—mr =
where you wish to save your results to. In the example opposite, the results are
required to be saved in the folder “Coastdown”.
. . . . . Acceleration v Velocity -
Highlight the required folder and click OK Accelerameter Calibration Timer
. Aquaplane
Ashtech Software
Backups
CableTester
AN Baud Rate Calculator
EP Platter
Coastdown
Zomms Drivers =
4 1 3
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View Menu

There are two options in this menu — “show IMU graph” and “graph File | View Options Help
timescale”

If an IMU is not to be used, ensure the “show IMU graph” is ticked. v Show IMU Graph
This will then include a graph of IMU data and a graph of the GPS Graph Timescale (s) 24
speed data. If you are not using an IMU, you can un-tick this graph

option and the software will only show the GPS speed graph.

e — R R Without IMU graph

Speed

Speed (mph)
o

T T T T T
-20 16 -12 -8 -4 0
Time (=)

: - | | | SN | | With IMU graph

IMUL X Acceleration

Speed

¥ Acceleration (G)
o
Speed (mph)
=)

T T T T T T T T T T
-20 16 -12 & -4 o -20 16 12 -8 -4
Time (=) Time (=)

You can also adjust the time base of the graph(s) by entering a different number into the Graph Timescale box. For
example, if you enter 10 this will place the graph graticules 10s apart, but if you enter 100 into this box, this will
place the graticules 100s apart, therefore allowing you to see more history on the screen. However, this will place a
little more demand on your computer and could potentially cause a slight delay in the updating of this graph so,
depending upon the specification of this, you may need to reduce this setting.

The default software setting for the graph timescale is 24s.

NOTE: The live data displayed on screen in the Coastdown software can suffers large delays, this is due to the
processor power of the PC.

If this delay is unacceptable firstly disable the IMU Graph window.
If a large delay is still present then try to reduce the timescale of the main graph window.
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Options Menu
The options menu contains four functions:

COM Port — to enable communication between the PC and the VBOX, Options  Help
you will need to define the appropriate communications port to allow g m R
the devices to “talk” to one another. %
X Custom Test Range ... Cop 2
To do this select:
Options _ MU 4 COM 3
» COM Port é Speed Units 3 m
»then choose appropriate COM port - COM 5
for example COM 4 -

Custom Test Range — Splitting the test into sub-ranges makes it easier  |File View | Options Help
to perform the test where you don’t have a very long test track — § comE
takes some considerable time and distance to coast from 125km/h to el A Port

. . -
5km/h — and so the entire range can be split into sub-ranges, as 00 %

follows: MU

o

Select: oy Peed Units 3
Options

» Custom Test Range

The following dialogue box will appear:

[] Enter Range e Simply define the start speed and end speed for each
Statspeed  [125 5 3 = | sub-range. ' |
Endspeed |5 &5 3 E | Eor add.ed resolution and' for further data processing
Increments  [10 fio i i | (if required), you can define the Coastdown time in
each sub-range to be reported at intermediate speed
o | _ored | steps as opposed to just the start and end speeds.

These speed steps are user definable.

In the example given above, the software is set-up to perform the entire test from 125km/h to 5km/h in 4 parts:
125km/h to 95km/h, 95km/h to 65km/h, 65km/h to 35km/h and 35km/h to 5km/h. In each sub-range, the
coastdown time will be reported at each 10km/h interval. For example, in the range 125 to 95

IMU - this allows you to enable the use of the optional Options

Inertial Measurement Unit (IMU), for supplementing the ﬁ COM Part b
GPS data with accelerometer data

Here you can enable the IMU for use and then use the % T D e T
alignment aid function to ensure that the IMU is set
correctly. This is described in more detail in section 8 -
GPS only and GPS + IMU

Alignment Aid ...

Speed Units
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Speed Units — This function allows you to switch the basic e om | iene | e
speed units The chosen speed unit will be applied to both GPS Test Rang ﬁ COM Port b
and IMU (if used) data. oL % Custom Test Range ...
To choose the required speed units, select: o R
Options =z
> Speed Units o ET | -
P then tick either km/h or mph rph
Help Menu
The help menu contains two options, one to access the online File View Options | Help
version of this user manual and another to access the version
details of the software, with contact details for Racelogic Test Range Manual ...

RACELOGIC
- QK ‘%@%

Software Version: 2.0.0 (Build 004)

@ Racelogic Ltd. 2008
Tel : +44{0)1280 23803
email : vbosEracelogic.co.uk  website : wew racelogic. co.uk

Processor Speed [&pprox]: 2390.0 MHz
2097151.99902344 tatal physical memory in kilobytes
1980644 available physical memory in kiobytes
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Replaying Saved Results

In the file menu, you can recall a saved Coastdown test and replay this. To File View Options Help
replay a saved file, select: ]
Load VBO File ...
File Lag File Location ...
» Load.VBO file
Replay Speed k

This will then bring up a dialogue box asking you to select the sample rate
of the file to be replayed. As the test is performed with a VBOX 111/VB3i,
you will have normally performed the test at a log rate of 100Hz. Select the
correct log rate and click OK.

SampleRate  [= |[E |25

Sample Rate of file

T 20Hz f« 100Hz

Once you have selected the sample rate and clicked [ Open : e
OK, you can then browse to the folder where you have Lok | 0 Somoe s - = e
. I= Mame Date modif.. Type Size
saved the .vbo file. =2 ko
Either, select the required file and click open, or T [#vBox00nd
double click this file and it will load into the Coastdown .
software. After a few seconds, the loading file screen T
will be displayed and when completed, the file will Nick Tomre
replay automatically. C-”.!
omputer
- : P
Loading file (=== Nower
5'] Z | File name: ﬂ Open
Files of type: | j Cancel
When replaying a logged file, you can choose the replay speed File View Options Help
from this menu.
Load VBO File ...
Select: Log File Location ...
File
» Replay Speed Replay Speed : Stap
P tick Slow, Medium or Fast . B
Medium
Fast
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Troubleshooting

No Satellite Lock

o Check that the antenna connection is clean and secure.

. Check the antenna cable for any damage.

. If a second antenna is available use this to eliminate the possibility of an antenna fault.

. Perform a GPS cold start and then leave the VBOX connected to the antenna and powered up in an open,

static position for 15 minutes.
No Communication

. If the Power LED on the VBOX is not illuminated then there is no power to the unit; check that battery is
charged or, if using a cigar lighter, check internal cigar lighter fuse.

. Check that the serial cable (CABO1) is plugged into socket RS232 on the VBOXIII/VB31/VB3I.

. Check that the serial cable is plugged into the COM port of the PC.

. Check that no other programs are using the same COM port.

o Try going into ‘VBOX Set-up’, and then exiting again.

. Disconnect the power to the VBOX, then reconnect it.

COM Port Unavailable

. The computer may have been started with a VBOX connected to it; disconnect the VBOX, restart the
computer then reconnect the VBOX.

. Another software package installed on your computer may have reserved the COM port.

Delayed Live data

o The live data displayed on screen in the Coastdown software can suffers large delays, this is due to the
processor power of the PC.

o If this delay is unacceptable firstly disable the IMU Graph window.

o If a large delay is still present then try to reduce the timescale of the main graph window .
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Contact Information

Racelogic Ltd

Unit 10 Swan Business Centre
Osier Way

Buckingham

MK18 1TB

UK

Tel: +44 (0) 1280 823803
Fax: +44 (0) 1280 823595

Email: support@racelogic.co.uk

Web: www.racelogic.co.uk

Revision Date Description Author
1.0 31/10/2008 First release NT
1.1 19/2/2009 Additions of VB3i compatibility and advice for delayed live data KB
1.2 6/12/2011 Manual edit & re-format JH
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